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Protect Microsoft Exchange Server databases

SnapCenter Plug-in for Microsoft Exchange Server
concepts

SnapCenter Plug-in for Microsoft Exchange Server overview

The SnapCenter Plug-in for Microsoft Exchange Server is a host-side component of the
NetApp SnapCenter Software that enables application-aware data protection
management of Exchange databases. The Plug-in for Exchange automates the backup
and restore of Exchange databases in your SnapCenter environment.

When the Plug-in for Exchange is installed, you can use SnapCenter with NetApp SnapMirror technology to
create mirror copies of backup sets on another volume and with NetApp SnapVault technology to perform disk-
to-disk backup replication for standards compliance or archival purposes.

If you want to restore and recover mails or mailbox instead of the complete Exchange Database, you can use
the Single Mailbox Recovery (SMBR) software. NetApp® Single Mailbox Recovery has come to the end of
availability (EOA) on May 12, 2023. NetApp will continue to support customers that have purchased mailbox
capacity, maintenance, and support through marketing part numbers introduced on June 24, 2020, for the
duration of the support entitlement.

NetApp Single Mailbox Recovery is a partner product provided by Ontrack. Ontrack PowerControls offers
capabilities that are similar to those of NetApp Single Mailbox Recovery. Customers can procure new Ontrack
PowerControls software licenses and Ontrack PowerControls maintenance and support renewals from Ontrack
(through licensingteam@ontrack.com) for granular mailbox recovery.

What you can do with SnapCenter Plug-in for Microsoft Exchange Server

You can use the Plug-in for Exchange to back up and restore Exchange Server
databases.

• View and manage an active inventory of Exchange Database Availability Groups (DAGs), databases, and
replica sets

• Define policies that provide the protection settings for backup automation

• Assign policies to resource groups

• Protect individual DAGs and databases

• Back up primary and secondary Exchange mailbox databases

• Restore databases from primary and secondary backups

Storage types supported by SnapCenter Plug-in for Microsoft Windows and for
Microsoft Exchange Server

SnapCenter supports a wide range of storage types on both physical machines and
virtual machines. You must verify whether support is available for your storage type
before installing the package for your host.
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SnapCenter provisioning and data protection support is available on Windows Server. For the latest
information about supported versions, see the NetApp Interoperability Matrix Tool.

Machine Storage type Provision using Support notes

Physical server FC-connected LUNs SnapCenter graphical
user interface (GUI) or
PowerShell cmdlets

Physical server iSCSI-connected LUNs SnapCenter GUI or
PowerShell cmdlets

VMware VM RDM LUNs connected by
an FC or iSCSI HBA

PowerShell cmdlets Physical compatibility only

VMDKs are
not
supported.

VMware VM iSCSI LUNs connected
directly to the guest
system by the iSCSI
initiator

SnapCenter GUI or
PowerShell cmdlets

VMDKs are
not
supported.

Hyper-V VM Virtual FC (vFC) LUNs
connected by a virtual
Fibre Channel Switch

SnapCenter GUI or
PowerShell cmdlets

You must use Hyper-V
Manager to provision
Virtual FC (vFC) LUNs
connected by a virtual
Fibre Channel Switch.

Hyper-V
pass
through
disks and
backing up
databases
on VHD(x)
that are
provisioned
on NetApp
storage are
not
supported.
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Machine Storage type Provision using Support notes

Hyper-V VM iSCSI LUNs connected
directly to the guest
system by the iSCSI
initiator

SnapCenter GUI or
PowerShell cmdlets

Hyper-V
pass
through
disks and
backing up
databases
on VHD(x)
that are
provisioned
on NetApp
storage are
not
supported.

Minimum ONTAP privileges required for Exchange plug-in

The minimum ONTAP privileges that are required vary according to the SnapCenter plug-ins you are using for
data protection.

All-access commands: Minimum privileges required for ONTAP 8.3.0 and later

event generate-autosupport-log

job history show

job stop
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All-access commands: Minimum privileges required for ONTAP 8.3.0 and later

lun

lun create

lun delete

lun igroup add

lun igroup create

lun igroup delete

lun igroup rename

lun igroup show

lun mapping add-reporting-nodes

lun mapping create

lun mapping delete

lun mapping remove-reporting-nodes

lun mapping show

lun modify

lun move-in-volume

lun offline

lun online

lun persistent-reservation clear

lun resize

lun serial

lun show

4



All-access commands: Minimum privileges required for ONTAP 8.3.0 and later

snapmirror policy add-rule

snapmirror policy modify-rule

snapmirror policy remove-rule

snapmirror policy show

snapmirror restore

snapmirror show

snapmirror show-history

snapmirror update

snapmirror update-ls-set

snapmirror list-destinations

version
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All-access commands: Minimum privileges required for ONTAP 8.3.0 and later

volume clone create

volume clone show

volume clone split start

volume clone split stop

volume create

volume destroy

volume file clone create

volume file show-disk-usage

volume offline

volume online

volume modify

volume qtree create

volume qtree delete

volume qtree modify

volume qtree show

volume restrict

volume show

volume snapshot create

volume snapshot delete

volume snapshot modify

volume snapshot rename

volume snapshot restore

volume snapshot restore-file

volume snapshot show

volume unmount
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All-access commands: Minimum privileges required for ONTAP 8.3.0 and later

vserver cifs

vserver cifs share create

vserver cifs share delete

vserver cifs shadowcopy show

vserver cifs share show

vserver cifs show

vserver export-policy

vserver export-policy create

vserver export-policy delete

vserver export-policy rule create

vserver export-policy rule show

vserver export-policy show

vserver iscsi

vserver iscsi connection show

vserver show

Read-only commands: Minimum privileges required for ONTAP 8.3.0 and later

network interface

network interface show

vserver

Prepare storage systems for SnapMirror and SnapVault replication

You can use a SnapCenter plug-in with ONTAP SnapMirror technology to create mirror copies of backup sets
on another volume, and with ONTAP SnapVault technology to perform disk-to-disk backup replication for
standards compliance and other governance-related purposes. Before you perform these tasks, you must
configure a data-protection relationship between the source and destination volumes and initialize the
relationship.

SnapCenter performs the updates to SnapMirror and SnapVault after it completes the Snapshot copy
operation. SnapMirror and SnapVault updates are performed as part of the SnapCenter job; do not create a
separate ONTAP schedule.
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If you are coming to SnapCenter from a NetApp SnapManager product and are satisfied with the
data protection relationships you have configured, you can skip this section.

A data protection relationship replicates data on primary storage (the source volume) to secondary storage (the
destination volume). When you initialize the relationship, ONTAP transfers the data blocks referenced on the
source volume to the destination volume.

SnapCenter does not support cascade relationships between SnapMirror and SnapVault
volumes (Primary > Mirror > Vault). You should use fanout relationships.

SnapCenter supports the management of version-flexible SnapMirror relationships. For details about version-
flexible SnapMirror relationships and how to set them up, see the ONTAP documentation.

SnapCenter does not support sync_mirror replication.

Define a backup strategy for Exchange Server resources

Defining a backup strategy before you create your backup jobs helps ensure that you
have the backups that you require to successfully restore your databases. Your Service
Level Agreement (SLA), Recovery Time Objective (RTO), and Recovery Point Objective
(RPO) largely determine your backup strategy.

An SLA defines the level of service expected and addresses many service-related issues, including the
availability and performance of service. The RTO is the time by when a business process must be restored
after a disruption in service. An RPO defines the strategy for the age of the files that must be recovered from
backup storage for regular operations to resume after a failure. The SLA, RTO, and RPO contribute to the
backup strategy.

Types of backups supported for Exchange database

Backing up Exchange mailboxes using SnapCenter requires that you choose the resource type, such as
databases and Database Availability Groups (DAG). Snapshot copy technology is leveraged to create online,
read-only copies of the volumes on which the resources reside.

Backup type Description

Full and log backup Backs up the databases and all transaction logs,
including the truncated logs.

After a full backup is complete, the Exchange Server
truncates the transaction logs that are already
committed to the database.

Typically, you should choose this option. However, if
your backup time is short, you can choose not to run
a transaction log backup with full backup.

Full backup Backs up databases and transaction logs.

The truncated transaction logs are not backed up.
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Backup type Description

Log backup Backs up all the transaction logs.

The truncated logs that are already committed to the
database are not backed up. If you schedule frequent
transaction log backups between full database
backups, you can choose granular recovery points.

Backup schedules for database plug-ins

Backup frequency (schedule type) is specified in policies; a backup schedule is specified in the resource group
configuration. The most critical factor in determining a backup frequency or schedule is the rate of change for
the resource and the importance of the data. You might back up a heavily used resource every hour, while you
might back up a rarely used resource once a day. Other factors include the importance of the resource to your
organization, your Service Level Agreement (SLA), and your Recover Point Objective (RPO).

An SLA defines the level of service expected and addresses many service-related issues, including the
availability and performance of service. An RPO defines the strategy for the age of the files that must be
recovered from backup storage for regular operations to resume after a failure. The SLA and RPO contribute to
the data protection strategy.

Even for a heavily used resource, there is no requirement to run a full backup more than once or twice a day.
For example, regular transaction log backups might be sufficient to ensure that you have the backups you
need. The more often you back up your databases, the fewer transaction logs SnapCenter has to use at
restore time, which can result in faster restore operations.

Backup schedules have two parts, as follows:

• Backup frequency

Backup frequency (how often backups are to be performed), called schedule type for some plug-ins, is part
of a policy configuration. You can select hourly, daily, weekly, or monthly as the backup frequency for the
policy. If you do not select any of these frequencies, then the policy created is an on-demand-only policy.
You can access policies by clicking Settings > Policies.

• Backup schedules

Backup schedules (exactly when backups are to be performed) are part of a resource group configuration.
For example, if you have a resource group that has a policy configured for weekly backups, you might
configure the schedule to back up every Thursday at 10:00 PM. You can access resource group schedules
by clicking Resources > Resource Groups.

Number of backup jobs needed for databases

Factors that determine the number of backup jobs that you need include the size of the resource, the number
of volumes used, the rate of change of the resource, and your Service Level Agreement (SLA).

Backup naming conventions

You can either use the default Snapshot copy naming convention or use a customized naming convention. The
default backup naming convention adds a timestamp to Snapshot copy names that helps you identify when the
copies were created.
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The Snapshot copy uses the following default naming convention:

resourcegroupname_hostname_timestamp

You should name your backup resource groups logically, as in the following example:

dts1_mach1x88_03-12-2015_23.17.26

In this example, the syntax elements have the following meanings:

• dts1 is the resource group name.

• mach1x88 is the host name.

• 03-12-2015_23.17.26 is the date and timestamp.

Alternatively, you can specify the Snapshot copy name format while protecting resources or resource groups
by selecting Use custom name format for Snapshot copy. For example,
customtext_resourcegroup_policy_hostname or resourcegroup_hostname. By default, the time stamp suffix is
added to the Snapshot copy name.

Backup retention options

You can choose either the number of days for which to retain backup copies or specify the number of backup
copies you want to retain, up to a ONTAP maximum of 255 copies. For example, your organization might
require that you retain 10 days of backup copies or 130 backup copies.

While creating a policy, you can specify the retention options for the backup type and the schedule type.

If you set up SnapMirror replication, the retention policy is mirrored on the destination volume.

SnapCenter deletes the retained backups that have retention labels that match the schedule type. If the
schedule type was changed for the resource or resource group, backups with the old schedule type label might
still remain on the system.

For long-term retention of backup copies, you should use SnapVault backup.

How long to retain transaction log backups on the source storage volume for Exchange Server

SnapCenter Plug-in for Microsoft Exchange Server needs transaction log backups to perform up-to-the-minute
restore operations, which restore your database to a time between two full backups.

For example, if Plug-in for Exchange took a full plus transaction log backup at 8:00 a.m. and another full plus
transaction log backup at 5:00 p.m., it could use the latest transaction log backup to restore the database to
any time between 8:00 a.m. and 5:00 p.m. If transaction logs are not available, Plug-in for Exchange can
perform point-in-time restore operations only, which restore a database to the time that Plug-in for Exchange
completed a full backup.

Typically, you require up-to-the-minute restore operations for only a day or two. By default, SnapCenter retains
a minimum of two days.
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Define a restore strategy for Exchange databases

Defining a restoration strategy for Exchange Server enables you to restore your database
successfully.

Sources for a restore operation in Exchange Server

You can restore an Exchange Server database from a backup copy on primary storage.

You can restore databases from primary storage only.

Types of restore operations supported for Exchange Server

You can use SnapCenter to perform different types of restore operations on Exchange resources.

• Restore up-to-the-minute

• Restore to a previous point in time

Restore up to the minute

In an up-to-the-minute restore operation, databases are recovered up to the point of failure. SnapCenter
accomplishes this by performing the following sequence:

1. Restores the databases from the full database backup that you select.

2. Applies all the transaction logs that were backed up, as well as any new logs that were created since the
most recent backup.

Transaction logs are moved ahead and applied to any selected databases.

Exchange creates a new log chain after a restore completes.

Best Practice: It is recommended that you perform a new full and log backup after a restore completes.

An up-to-the-minute restore operation requires a contiguous set of transaction logs.

After you perform an up-to-the-minute restore, the backup you used for the restore is available only for
point-in-time restore operations.

If you do not need to retain up-to-the-minute restore capability for all backups, you can configure your
system’s transaction log backup retention through the backup policies.

Restore to a previous point in time

In a point-in-time restore operation, databases are restored only to a specific time from the past. A point-in-time
restore operation occurs in the following restore situations:

• The database is restored to a given time in a backed-up transaction log.

• The database is restored, and only a subset of backed-up transaction logs are applied to it.
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Install SnapCenter Plug-in for Microsoft Exchange Server

Installation workflow of SnapCenter Plug-in for Microsoft Exchange Server

You should install and set up SnapCenter Plug-in for Microsoft Exchange Server if you
want to protect Exchange databases.

Prerequisites to add hosts and install SnapCenter Plug-in for Microsoft Exchange
Server

Before you add a host and install the plug-in packages, you must complete all the
requirements.

• If you are using iSCSI, the iSCSI service must be running.

• You must have a domain user with local administrator privileges with local login permissions on the remote
host.

• You must be using Microsoft Exchange Server 2013, 2016, or 2019 for standalone and Database
Availability Group configurations.

• When installing a plug-in on a Windows host, if you specify a credential that is not built-in or if the user
belongs to a local workgroup user, you must disable UAC on the host.

• If you manage cluster nodes in SnapCenter, you must have a user with administrative privileges to all the
nodes in the cluster.

• You must have a user with administrative permissions on the Exchange Server.

• If SnapManager for Microsoft Exchange Server and SnapDrive for Windows are already installed, you must
unregister the VSS Hardware Provider used by SnapDrive for Windows before you install Plug-in for
Exchange on the same Exchange Server to ensure successful data protection using SnapCenter.

• If SnapManager for Microsoft Exchange Server and Plug-in for Exchange are installed on the same server,
you must suspend or delete from the Windows scheduler all schedules created by SnapManager for
Microsoft Exchange Server.

• The host must be resolvable to the fully qualified domain name (FQDN) from the server. If the hosts file is
modified to make it resolvable and if both the short name and the FQDN are specified in the hosts file,
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create an entry in the SnapCenter hosts file in the following format: <ip_address> <host_fqdn>

<host_name>.

• Ensure the following ports are not blocked in the firewall, otherwise the add host operation fails. To resolve
this issue, you must configure the dynamic port range. For more information, see Microsoft documentation.

◦ Port range 50000 - 51000 for Windows 2016 and Exchange 2016

◦ Port range 6000 - 6500 for Windows 2012 R2 and Exchange 2013

◦ Port range 49152 - 65536 for Windows 2019

To identify the port range, execute the following commands:

• netsh int ipv4 show dynamicport tcp

• netsh int ipv4 show dynamicport udp

• netsh int ipv6 show dynamicport tcp

• netsh int ipv6 show dynamicport udp

Host requirements to install SnapCenter Plug-ins Package for Windows

Before you install the SnapCenter Plug-ins Package for Windows, you should be familiar with some basic host
system space requirements and sizing requirements.

Item Requirements

Operating Systems Microsoft Windows

For the latest information about supported versions,
see the NetApp Interoperability Matrix Tool.

Minimum RAM for the SnapCenter plug-in on host 1 GB

Minimum install and log space for the SnapCenter
plug-in on host

5 GB

You should allocate sufficient disk
space and monitor the storage
consumption by the logs folder. The log
space required varies depending on
the number of the entities to be
protected and the frequency of data
protection operations. If there is no
sufficient disk space, the logs will not
be created for the recently run
operations.
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Item Requirements

Required software packages • Microsoft .NET Framework 4.7.2 or later

• Windows Management Framework (WMF) 4.0 or
later

• PowerShell 4.0 or later

For the latest information about supported versions,
see the NetApp Interoperability Matrix Tool.

For .NET troubleshooting information, see
SnapCenter upgrade or install fails for legacy systems
that do not have internet connectivity.

Exchange Server privileges required

To enable SnapCenter to add Exchange Server or DAG, and to install SnapCenter Plug-in for Microsoft
Exchange Server on a host or DAG, you must configure SnapCenter with credentials for a user with a
minimum set of privileges and permissions.

You must have a domain user with local administrator privileges, and with local login permissions on the
remote Exchange host, as well as administrative permissions on all the nodes in the DAG. The domain user
requires the following minimum permissions:

• Add-MailboxDatabaseCopy

• Dismount-Database

• Get-AdServerSettings

• Get-DatabaseAvailabilityGroup

• Get-ExchangeServer

• Get-MailboxDatabase

• Get-MailboxDatabaseCopyStatus

• Get-MailboxServer

• Get-MailboxStatistics

• Get-PublicFolderDatabase

• Move-ActiveMailboxDatabase

• Move-DatabasePath -ConfigurationOnly:$true

• Mount-Database

• New-MailboxDatabase

• New-PublicFolderDatabase

• Remove-MailboxDatabase

• Remove-MailboxDatabaseCopy

• Remove-PublicFolderDatabase

• Resume-MailboxDatabaseCopy

• Set-AdServerSettings
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• Set-MailboxDatabase -allowfilerestore:$true

• Set-MailboxDatabaseCopy

• Set-PublicFolderDatabase

• Suspend-MailboxDatabaseCopy

• Update-MailboxDatabaseCopy

Configure gMSA on Windows Server 2012 or later

Before you install the SnapCenter Plug-ins Package for Windows, you should be familiar with some basic host
system space requirements and sizing requirements.

Item Requirements

Operating Systems Microsoft Windows

For the latest information about supported versions,
see the NetApp Interoperability Matrix Tool.

Minimum RAM for the SnapCenter plug-in on host 1 GB

Minimum install and log space for the SnapCenter
plug-in on host

5 GB

You should allocate sufficient disk
space and monitor the storage
consumption by the logs folder. The log
space required varies depending on
the number of the entities to be
protected and the frequency of data
protection operations. If there is no
sufficient disk space, the logs will not
be created for the recently run
operations.

Required software packages • Microsoft .NET Framework 4.7.2 or later

• Windows Management Framework (WMF) 4.0 or
later

• PowerShell 4.0 or later

For the latest information about supported versions,
see the NetApp Interoperability Matrix Tool.

For .NET troubleshooting information, see
SnapCenter upgrade or install fails for legacy systems
that do not have internet connectivity.

Set up credentials for SnapCenter Plug-in for Windows

SnapCenter uses credentials to authenticate users for SnapCenter operations. You
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should create credentials for installing the plug-in package and additional credentials for
performing data protection operations on databases.

About this task

You must set up credentials for installing plug-ins on Windows hosts. Although you can create credentials for
Windows after deploying hosts and installing plug-ins, the best practice is to create credentials after you add
SVMs, before you deploy hosts and install plug-ins.

Set up the credentials with administrator privileges, including administrator rights on the remote host.

If you set up credentials for individual resource groups and the username does not have full admin privileges,
you must assign at least the resource group and backup privileges to the username.

Steps

1. In the left navigation pane, click Settings.

2. In the Settings page, click Credential.

3. Click New.

The Credential window is displayed.

4. In the Credential page, do the following:

For this field… Do this…

Credential name Enter a name for the credential.
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For this field… Do this…

Username Enter the user name used for authentication.

• Domain administrator or any member of the
administrator group

Specify the domain administrator or any
member of the administrator group on the
system on which you are installing the
SnapCenter plug-in. Valid formats for the
Username field are:

◦ NetBIOS\UserName

◦ Domain FQDN\UserName

• Local administrator (for workgroups only)

For systems that belong to a workgroup, specify
the built-in local administrator on the system on
which you are installing the SnapCenter plug-in.
You can specify a local user account that
belongs to the local administrators group if the
user account has elevated privileges or the User
Access control feature is disabled on the host
system. The valid format for the Username field

is: UserName

Password Enter the password used for authentication.

Authentication Select Windows as the authentication mode.

5. Click OK.

Configure gMSA on Windows Server 2012 or later

Windows Server 2012 or later enables you to create a group Managed Service Account (gMSA) that provides
automated service account password management from a managed domain account.

What you will need

• You should have a Windows Server 2012 or later domain controller.

• You should have a Windows Server 2012 or later host, which is a member of the domain.

Steps

1. Create a KDS root key to generate unique passwords for each object in your gMSA.

2. For each domain, run the following command from the Windows domain controller: Add-KDSRootKey
-EffectiveImmediately

3. Create and configure your gMSA:
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a. Create a user group account in the following format:

domainName\accountName$

b. Add computer objects to the group.

c. Use the user group you just created to create the gMSA.

For example,

New-ADServiceAccount -name <ServiceAccountName> -DNSHostName <fqdn>

-PrincipalsAllowedToRetrieveManagedPassword <group>

-ServicePrincipalNames <SPN1,SPN2,…>

d. Run Get-ADServiceAccount command to verify the service account.

4. Configure the gMSA on your hosts:

a. Enable the Active Directory module for Windows PowerShell on the host where you want to use the
gMSA account.

To do this, run the following command from PowerShell:

PS C:\> Get-WindowsFeature AD-Domain-Services

Display Name                           Name                Install

State

------------                           ----

-------------

[ ] Active Directory Domain Services   AD-Domain-Services  Available

PS C:\> Install-WindowsFeature AD-DOMAIN-SERVICES

Success Restart Needed Exit Code      Feature Result

------- -------------- ---------      --------------

True    No             Success        {Active Directory Domain

Services, Active ...

WARNING: Windows automatic updating is not enabled. To ensure that

your newly-installed role or feature is

automatically updated, turn on Windows Update.

b. Restart your host.

c. Install the gMSA on your host by running the following command from the PowerShell command

prompt: Install-AdServiceAccount <gMSA>

d. Verify your gMSA account by running the following command: Test-AdServiceAccount <gMSA>
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5. Assign the administrative privileges to the configured gMSA on the host.

6. Add the Windows host by specifying the configured gMSA account in the SnapCenter Server.

SnapCenter Server will install the selected plug-ins on the host and the specified gMSA will be used as the
service log on account during the plug-in installation.

Add hosts and install Plug-in for Exchange

You can use the SnapCenter Add Host page to add Windows hosts. The Plug-in for
Exchange is automatically installed on the specified host. This is the recommended
method for installing plug-ins. You can add a host and install a plug-in either for an
individual host or a cluster.

What you will need

• You must be a user that is assigned to a role that has the plug-in install and uninstall permissions, such as
the SnapCenter Admin.

• When installing a plug-in on a Windows host, if you specify a credential that is not built-in, or if the user
belongs to a local workgroup user, you must disable UAC on the host.

• The message queueing service must be running.

• If you are using group Managed Service Account (gMSA), you should configure gMSA with administrative
privileges. For information, see Configure group Managed Service Account on Windows Server 2012 or
later for Microsoft Exchange Server.

About this task

• You cannot add a SnapCenter Server as a plug-in host to another SnapCenter Server.

• You can add a host and install plug-in packages either for an individual host or a cluster.

• If an exchange node is part of a DAG, you cannot add only one node into the SnapCenter Server.

• If you are installing plug-ins on a cluster (Exchange DAG), they are installed on all of the nodes of the
cluster even if some of nodes do not have databases on NetApp LUNs.

Beginning with SnapCenter 4.6, SCE supports multitenancy and you can add a host using the following
methods:

Add host operation 4.5 and earlier 4.6 and later

Add IP-less DAG in cross or
different domain

Not supported Supported

Add multiple IP DAGs with unique
names, residing in the same or
cross domain

Supported Supported

Add multiple IP or IP-less DAGs
which have same host names
and/or DB name in cross domain

Not supported Supported

Add multiple IP/IP-less DAGs with
the same name and cross domain

Not supported Supported
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Add host operation 4.5 and earlier 4.6 and later

Add multiple standalone hosts with
the same name and cross domain

Not supported Supported

Plug-in for Exchange depends on SnapCenter Plug-ins Package for Windows, and the versions must be the
same. During the Plug-in for Exchange installation, SnapCenter Plug-ins Package for Windows is selected by
default and is installed along with the VSS Hardware Provider.

If SnapManager for Microsoft Exchange Server and SnapDrive for Windows are already installed, and you
want to install Plug-in for Exchange on the same Exchange Server, you must unregister the VSS Hardware
Provider used by SnapDrive for Windows because it is incompatible with the VSS Hardware Provider installed
with Plug-in for Exchange and SnapCenter Plug-ins Package for Windows. For more information, see How to
manually register the Data ONTAP VSS Hardware Provider.

Steps

1. In the left navigation pane, click Hosts.

2. Verify that Managed Hosts is selected at the top.

3. Click Add.

4. In the Hosts page, do the following:

For this field… Do this…

Host Type Select Windows as the host type.

SnapCenter Server adds the host and then installs
on the host the Plug-in for Windows and the Plug-in
for Exchange if they are not already installed.

Plug-in for Windows and Plug-in for Exchange must
be the same version. If a different version of Plug-in
for Windows was previously installed, SnapCenter
updates the version as part of the installation.
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For this field… Do this…

Host name Enter the fully qualified domain name (FQDN) or the
IP address of the host.

SnapCenter depends on the proper configuration of
the DNS. Therefore, the best practice is to enter the
fully qualified domain name (FQDN).

An IP address is supported for untrusted domain
hosts only if it resolves to the FQDN.

If you are adding a host using SnapCenter and it is
part of a subdomain, you must provide the FQDN.

You can enter IP addresses or the FQDN of one of
the following:

• Stand-alone host

• Exchange DAG

For an Exchange DAG, you can:

◦ Add a DAG by providing the DAG name,
DAG IP address, node name, or node IP
address.

◦ Add the IP less DAG cluster by providing
the IP address or the FQDN of one of the
DAG cluster nodes.

◦ Add IP less DAG that resides in the same
domain or different domain. You can also
add multiple IP/IP less DAGs with the same
name but different domains.

For a stand-alone host or an
Exchange DAG (cross-domain or
same domain), it is recommended to
provide FQDN or the IP address of
the host or DAG.
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For this field… Do this…

Credentials Select the credential name that you created, or
create the new credentials.

The credential must have administrative rights on
the remote host. For details, see information about
creating a credential.

You can view details about the credentials by
positioning your cursor over the credential name
that you specified.

Credentials authentication mode is
determined by the host type that you
specify in the Add Host wizard.

5. In the Select Plug-ins to Install section, select the plug-ins to install.

When you select Plug-in for Exchange, SnapCenter Plug-in for Microsoft SQL Server is deselected
automatically. Microsoft recommends that SQL Server and Exchange server not be installed on the same
system due to the amount of memory used and other resource usage required by Exchange.

6. (Optional) Click More Options.

For this field… Do this…

Port Either retain the default port number or specify the
port number.

The default port number is 8145. If the SnapCenter
Server was installed on a custom port, that port
number will be displayed as the default port.

If you manually installed the plug-ins
and specified a custom port, you
must specify the same port.
Otherwise, the operation fails.

Installation Path The default path is C:\Program

Files\NetApp\SnapCenter.

You can optionally customize the path.

Add all hosts in the DAG Select this check box when you add a DAG.

Skip preinstall checks Select this check box if you already installed the
plug-ins manually and you do not want to validate
whether the host meets the requirements for
installing the plug-in.
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For this field… Do this…

Use group Managed Service Account (gMSA) to run
the plug-in services

Select this check box if you want to use group
Managed Service Account (gMSA) to run the plug-in
services.

Provide the gMSA name in the following format:
domainName\accountName$.

gMSA will be used as a log on
service account only for SnapCenter
Plug-in for Windows service.

7. Click Submit.

If you have not selected the Skip prechecks check box, the host is validated to determine whether it meets
the requirements to install the plug-in. If the minimum requirements are not met, the appropriate error or
warning messages are displayed.

If the error is related to disk space or RAM, you can update the web.config file located at C:\Program

Files\NetApp\SnapCenter WebApp to modify the default values. If the error is related to other
parameters, you must fix the issue.

In an HA setup, if you are updating web.config file, you must update the file on both nodes.

8. Monitor the installation progress.

Install Plug-in for Exchange from the SnapCenter Server host using PowerShell
cmdlets

You should install the Plug-in for Exchange from the SnapCenter GUI. If you do not want
to use the GUI, you can use PowerShell cmdlets on the SnapCenter Server host or on a
remote host.

What you will need

• SnapCenter Server must have been installed and configured.

• You must be a local administrator on the host or a user with administrative privileges.

• You must be a user that is assigned to a role that has the plug-in, install, and uninstall permissions, such as
the SnapCenter Admin.

• You must have reviewed the installation requirements and types of supported configurations before
installing the Plug-in for Exchange.

• The host on which you want the Plug-in for Exchange installed must be a Windows host.

Steps

1. On the SnapCenter Server host, establish a session using the Open-SmConnection cmdlet, and then enter
your credentials.

2. Add the host on which you want to install the Plug-in for Exchange using the Add-SmHost cmdlet with the
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required parameters.

The information regarding the parameters that can be used with the cmdlet and their descriptions can be
obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter
Software Cmdlet Reference Guide.

The host can be a standalone host or a DAG. If you specify a DAG, the -IsDAG parameter is required.

3. Install the Plug-in for Exchange using the Install-SmHostPackage cmdlet with the required parameters.

This command installs the Plug-in for Exchange on the specified host, and then registers the plug-in with
SnapCenter.

Install the SnapCenter Plug-in for Exchange silently from the command line

You should install Plug-in for Exchange from within the SnapCenter user interface.
However, if you cannot for some reason, you can run the Plug-in for Exchange installation
program unattended in silent mode from the Windows command line.

What you will need

• You must have backed up your Microsoft Exchange Server resources.

• You must have installed the SnapCenter plug-in packages.

• You must delete the earlier release of SnapCenter Plug-in for Microsoft SQL Server before installing.

For more information, see How to Install a SnapCenter Plug-In manually and directly from the Plug-In Host.

Steps

1. Validate whether C:\temp folder exists on the plug-in host and the logged in user has full access to it.

2. Download the SnapCenter Plug-in for Microsoft Windows from
C:\ProgramData\NetApp\SnapCenter\Package Repository.

This path is accessible from the host where the SnapCenter Server is installed.

3. Copy the installation file to the host on which you want to install the plug-in.

4. From a Windows command prompt on the local host, navigate to the directory to which you saved the plug-
in installation files.

5. Enter the following command to install replacing the variables with your data:

snapcenter_windows_host_plugin.exe"/silent /debuglog"<Debug_Log_Path>" /log"<Log_Path>"

BI_SNAPCENTER_PORT=<Num> SUITE_INSTALLDIR="<Install_Directory_Path>"

BI_SERVICEACCOUNT=<domain\administrator> BI_SERVICEPWD=<password>

ISFeatureInstall=HPPW,SCW,SCE

For example:

C:\ProgramData\NetApp\SnapCenter\Package Repository\snapcenter_windows_host_plugin.exe"/silent

/debuglog"C:\HPPW_SCSQL_Install.log" /log"C:\temp" BI_SNAPCENTER_PORT=8145

SUITE_INSTALLDIR="C:\Program Files\NetApp\SnapCenter"

BI_SERVICEACCOUNT=domain\administrator BI_SERVICEPWD=password
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ISFeatureInstall=HPPW,SCW,SCE

All the parameters passed during the installation of Plug-in for Exchange are case sensitive.

a. /silent /debuglog"C:\Installdebug.log" /log"C:\temp" BI_SNAPCENTER_PORT=8145

SUITE_INSTALLDIR="C:\Program Files" BI_SERVICEACCOUNT=demo\administrator

BI_SERVICEPWD=Netapp1! ISFeatureInstall=HPPW,SCW

Enter the following values for the variables:

Variable Value

/debuglog"<Debug_Log_Path> Specify the name and location of the suite
installer log file, as in the following example:

Setup.exe /debuglog"C:\PathToLog\setupexe.log

BI_SNAPCENTER_PORT Specify the port on which SnapCenter
communicates with SMCore.

SUITE_INSTALLDIR Specify host plug-in package installation directory.

BI_SERVICEACCOUNT Specify SnapCenter Plug-in for Microsoft
Windows web service account.

BI_SERVICEPWD Specify the password for SnapCenter Plug-in for
Microsoft Windows web service account.

ISFeatureInstall Specify the solution to be deployed by
SnapCenter on remote host.

6. Monitor the Windows task scheduler, the main installation log file C:\Installdebug.log, and the additional
installation files in C:\Temp.

7. Monitor the %temp% directory to check if the msiexe.exe installers are installing the software without
errors.

The installation of Plug-in for Exchange registers the plug-in on the host and not on the
SnapCenter Server. You can register the plug-in on the SnapCenter Server by adding the
host using the SnapCenter GUI or PowerShell cmdlet. After the host is added, the plug-in is
automatically discovered.

Monitor SnapCenter plug-in package installation status

You can monitor the progress of SnapCenter plug-in package installation by using the Jobs page. You might
want to check the progress of installation to determine when it is complete or if there is an issue.

About this task

The following icons appear on the Jobs page and indicate the state of the operation:
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•
 In progress

•  Completed successfully

•  Failed

•
 Completed with warnings or could not start due to warnings

•  Queued

Steps

1. In the left navigation pane, click Monitor.

2. In the Monitor page, click Jobs.

3. In the Jobs page, to filter the list so that only plug-in installation operations are listed, do the following:

a. Click Filter.

b. Optional: Specify the start and end date.

c. From the Type drop-down menu, select Plug-in installation.

d. From the Status drop-down menu, select the installation status.

e. Click Apply.

4. Select the installation job and click Details to view the job details.

5. In the Job Details page, click View logs.

Configure CA Certificate

Generate CA Certificate CSR file

You can generate a Certificate Signing Request (CSR) and import the certificate that can be obtained from a
Certificate Authority (CA) using the generated CSR. The certificate will have a private key associated with it.

CSR is a block of encoded text that is given to an authorized certificate vendor to procure the signed CA
certificate.

For information to generate a CSR, see How to generate CA Certificate CSR file.

If you own the CA certificate for your domain (*.domain.company.com) or your system
(machine1.domain.company.com), you can skip generating the CA Certificate CSR file. You can
deploy the existing CA certificate with SnapCenter.

For cluster configurations, the cluster name (virtual cluster FQDN), and the respective host names should be
mentioned in the CA certificate. The certificate can be updated by filling the Subject Alternative Name (SAN)
field before procuring the certificate. For a wild card certificate (*.domain.company.com), the certificate will
contain all the hostnames of the domain implicitly.

Import CA certificates

You must import the CA certificates to the SnapCenter Server and the Windows host plug-ins using the
Microsoft management console (MMC).

Steps
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1. Go to the Microsoft management console (MMC), and then click File > Add/Remove Snapin.

2. In the Add or Remove Snap-ins window, select Certificates and then click Add.

3. In the Certificates snap-in window, select the Computer account option, and then click Finish.

4. Click Console Root > Certificates – Local Computer > Trusted Root Certification Authorities >
Certificates.

5. Right-click on the folder “Trusted Root Certification Authorities”, and then select All Tasks > Import to start
the import wizard.

6. Complete the wizard, as follows:

In this wizard window… Do the following…

Import Private Key Select the option Yes, import the private key, and
then click Next.

Import File Format Make no changes; click Next.

Security Specify the new password to be used for the
exported certificate, and then click Next.

Completing the Certificate Import Wizard Review the summary, and then click Finish to start
the import.

Importing certificate should be bundled with the private key (supported formats are: *.pfx,
*.p12, and *.p7b).

7. Repeat Step 5 for the “Personal” folder.

Get the CA certificate thumbprint

A certificate thumbprint is a hexadecimal string that identifies a certificate. A thumbprint is calculated from the
content of the certificate using a thumbprint algorithm.

Steps

1. Perform the following on the GUI:

a. Double-click the certificate.

b. In the Certificate dialog box, click the Details tab.

c. Scroll through the list of fields and click Thumbprint.

d. Copy the hexadecimal characters from the box.

e. Remove the spaces between the hexadecimal numbers.

For example, if the thumbprint is: "a9 09 50 2d d8 2a e4 14 33 e6 f8 38 86 b0 0d 42 77 a3 2a 7b", after
removing the spaces, it will be: "a909502dd82ae41433e6f83886b00d4277a32a7b".

2. Perform the following from PowerShell:

a. Run the following command to list the thumbprint of the installed certificate and identify the recently
installed certificate by the subject name.
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Get-ChildItem -Path Cert:\LocalMachine\My

b. Copy the thumbprint.

Configure CA certificate with Windows host plug-in services

You should configure the CA certificate with Windows host plug-in services to activate the installed digital
certificate.

Perform the following steps on the SnapCenter Server and all the plug-in hosts where CA certificates are
already deployed.

Steps

1. Remove the existing certificate binding with SMCore default port 8145, by running the following command:

> netsh http delete sslcert ipport=0.0.0.0:_<SMCore Port>

For example:

> netsh http delete sslcert ipport=0.0.0.0:8145

2. Bind the newly installed certificate with the Windows host plug-in services, by running the following
commands:

> $cert = “<certificate thumbprint>”

> $guid = [guid]::NewGuid().ToString("B")

> netsh http add sslcert ipport=0.0.0.0: <SMCore Port> certhash=$cert

appid="$guid"

For example:

> $cert = “a909502dd82ae41433e6f83886b00d4277a32a7b”

> $guid = [guid]::NewGuid().ToString("B")

> netsh http add sslcert ipport=0.0.0.0:8145 certhash=$cert

appid="$guid"

Enable CA Certificates for plug-ins

You should configure the CA certificates and deploy the CA certificates in the SnapCenter Server and the
corresponding plug-in hosts. You should enable the CA certificate validation for the plug-ins.

What you will need

• You can enable or disable the CA certificates using the run Set-SmCertificateSettings cmdlet.

• You can display the certificate status for the plug-ins using the Get-SmCertificateSettings.

The information regarding the parameters that can be used with the cmdlet and their descriptions can be
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obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter Software
Cmdlet Reference Guide.

Steps

1. In the left navigation pane, click Hosts.

2. In the Hosts page, click Managed Hosts.

3. Select single or multiple plug-in hosts.

4. Click More options.

5. Select Enable Certificate Validation.

After you finish

The Managed Hosts tab host displays a padlock and the color of the padlock indicates the status of the
connection between SnapCenter Server and the plug-in host.

•  indicates that the CA certificate is neither enabled nor assigned to the plug-in host.

•  indicates that the CA certificate is successfully validated.

•  indicates that the CA certificate could not be validated.

•  indicates that the connection information could not be retrieved.

When the status is yellow or green, the data protection operations completes successfully.

Configure SnapManager 7.x for Exchange and SnapCenter to coexist

To enable SnapCenter Plug-in for Microsoft Exchange Server to coexist with
SnapManager for Microsoft Exchange Server, you need to install SnapCenter Plug-in for
Microsoft Exchange Server on the same Exchange Server on which SnapManager for
Microsoft Exchange Server is installed, disable SnapManager for Exchange schedules,
and configure new schedules and backups using SnapCenter Plug-in for Microsoft
Exchange Server.

What you will need

• SnapManager for Microsoft Exchange Server and SnapDrive for Windows are already installed, and
SnapManager for Microsoft Exchange Server backups exist on the system and in the SnapInfo directory.

• You should have deleted or reclaimed backups taken by SnapManager for Microsoft Exchange Server that
you no longer require.

• You should have suspended or deleted all schedules created by SnapManager for Microsoft Exchange
Server from the Windows scheduler.

• SnapCenter Plug-in for Microsoft Exchange Server and SnapManager for Microsoft Exchange Server can
coexist on the same Exchange Server, but you cannot upgrade existing SnapManager for Microsoft
Exchange Server installations to SnapCenter.

SnapCenter does not provide an option for the upgrade.

• SnapCenter does not support restoring Exchange databases from SnapManager for Microsoft Exchange
Server backup.
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If you do not uninstall SnapManager for Microsoft Exchange Server after the SnapCenter Plug-in for
Microsoft Exchange Server installation and later want to restore a SnapManager for Microsoft Exchange
Server backup, you must perform additional steps.

Steps

1. Using PowerShell on all DAG nodes, determine whether the SnapDrive for Windows VSS Hardware
Provider is registered: vssadmin list providers

C:\Program Files\NetApp\SnapDrive>vssadmin list providers

vssadmin 1.1 - Volume Shadow Copy Service administrative command-line

tool

(C) Copyright 2001-2013 Microsoft Corp.

Provider name: 'Data ONTAP VSS Hardware Provider'

   Provider type: Hardware

   Provider Id: {ddd3d232-a96f-4ac5-8f7b-250fd91fd102}

   Version: 7. 1. 4. 6845

2. From the SnapDrive directory, unregister the VSS Hardware Provider from SnapDrive for Windows:
navssprv.exe -r service –u

3. Verify that the VSS Hardware Provider was removed: vssadmin list providers

4. Add the Exchange host to SnapCenter, and then install the SnapCenter Plug-in for Microsoft Windows and
the SnapCenter Plug-in for Microsoft Exchange Server.

5. From the SnapCenter Plug-in for Microsoft Windows directory on all DAG nodes, verify that the VSS
Hardware Provider is registered: vssadmin list providers

[PS] C:\Windows\system32>vssadmin list providers

vssadmin 1.1 - Volume Shadow Copy Service administrative command-line

tool

(C) Copyright 2001-2013 Microsoft Corp.

Provider name: 'Data ONTAP VSS Hardware Provider'

   Provider type: Hardware

   Provider Id: {31fca584-72be-45b6-9419-53a3277301d1}

   Version: 7. 0. 0. 5561

6. Stop the SnapManager for Microsoft Exchange Server backup schedules.

7. Using the SnapCenter GUI, create on-demand backups, configure scheduled backups, and configure
retention settings.

8. Uninstall SnapManager for Microsoft Exchange Server.

If you do not uninstall SnapManager for Microsoft Exchange Server now and later want to restore a
SnapManager for Microsoft Exchange Server backup:
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a. Unregister SnapCenter Plug-in for Microsoft Exchange Server from all DAG nodes: navssprv.exe -r

service -u

C:\Program Files\NetApp\SnapCenter\SnapCenter Plug-in for Microsoft

Windows>navssprv.exe -r service -u

b. From the C:\Program Files\NetApp\SnapDrive\ directory, register SnapDrive for Windows on all DAG
nodes: navssprv.exe -r service -a hostname\\username -p password

Install SnapCenter Plug-in for VMware vSphere

If your database is stored on virtual machines (VMs), or if you want to protect VMs and
datastores, you must deploy the SnapCenter Plug-in for VMware vSphere virtual
appliance.

For information to deploy, see Deployment Overview.

Deploy CA certificate

To configure the CA Certificate with SnapCenter Plug-in for VMware vSphere, see Create or import SSL
certificate.

Configure the CRL file

SnapCenter Plug-in for VMware vSphere looks for the CRL files in a pre-configured directory. Default directory
of the CRL files for SnapCenter Plug-in for VMware vSphere is /opt/netapp/config/crl.

You can place more than one CRL file in this directory. The incoming certificates will be verified against each
CRL.

Prepare for data protection

Before performing any data protection operation such as backup, clone, or restore operations, you must define
your strategy and set up the environment. You can also set up the SnapCenter Server to use SnapMirror and
SnapVault technology.

To take advantage of SnapVault and SnapMirror technology, you must configure and initialize a data protection
relationship between the source and destination volumes on the storage device. You can use NetAppSystem
Manager or you can use the storage console command line to perform these tasks.

Find more information

Getting started with the REST API

Prerequisites for using the SnapCenter Plug-in for Microsoft Exchange Server

Before you use the Plug-in for Exchange, the SnapCenter administrator must install and configure the
SnapCenter Server and perform the prerequisite tasks.

• Install and configure SnapCenter Server.
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• Log in to SnapCenter.

• Configure the SnapCenter environment by adding or assigning storage system connections and creating a
credential.

SnapCenter does not support multiple SVMs with the same name on different clusters. Each
SVM supported by SnapCenter must have a unique name.

• Add hosts, install the SnapCenter Plug-in for Microsoft Windows and the SnapCenter Plug-in for Microsoft
Exchange Server, and discover (refresh) the resources.

• Perform host-side storage provisioning using the SnapCenter Plug-in for Microsoft Windows.

• If you are using SnapCenter Server to protect Exchange databases that reside on VMware RDM LUNs,
you must deploy the SnapCenter Plug-in for VMware vSphere and register the plug-in with SnapCenter.
The SnapCenter Plug-in for VMware vSphere documentation has more information.

VMDKs are not supported.

• Move an existing Microsoft Exchange Server database from a local disk to supported storage using
Microsoft Exchange tools.

• Set up SnapMirror and SnapVault relationships, if you want backup replication.

For SnapCenter 4.1.1 users, the SnapCenter Plug-in for VMware vSphere 4.1.1 documentation has
information on protecting virtualized databases and file systems. For SnapCenter 4.2.x users, the NetApp Data
Broker 1.0 and 1.0.1, documentation has information on protecting virtualized databases and file systems
using the SnapCenter Plug-in for VMware vSphere that is provided by the Linux-based NetApp Data Broker
virtual appliance (Open Virtual Appliance format). For SnapCenter 4.3.x users, the SnapCenter Plug-in for
VMware vSphere 4.3 documentation has information on protecting virtualized databases and file systems
using the Linux-based SnapCenter Plug-in for VMware vSphere virtual appliance (Open Virtual Appliance
format).

SnapCenter Plug-in for VMware vSphere documentation

How resources, resource groups, and policies are used for protecting Exchange
Server

Before you use SnapCenter, it is helpful to understand basic concepts related to the backup, restore, and
reseed operations you want to perform. You interact with resources, resource groups, and policies for different
operations.

• Resources are typically mailbox databases or Microsoft Exchange Database Availability Group (DAG) that
you back up with SnapCenter.

• A SnapCenter resource group, is a collection of resources on a host or Exchange DAG, and the resource
group can include either a whole DAG or individual databases.

When you perform an operation on a resource group, you perform that operation on the resources defined
in the resource group according to the schedule you specify for the resource group.

You can back up on demand a single resource or a resource group. You also can perform scheduled
backups for single resources and resource groups.

The resource groups were formerly known as datasets.
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• The policies specify the backup frequency, copy retention, scripts, and other characteristics of data
protection operations.

When you create a resource group, you select one or more policies for that group. You can also select one
or more policies when you perform a backup on demand for a single resource.

Think of a resource group as defining what you want to protect and when you want to protect it in terms of day
and time. Think of a policy as defining how you want to protect it. If you are backing up all databases of a host,
for example, you might create a resource group that includes all the databases in the host. You could then
attach two policies to the resource group: a daily policy and an hourly policy. When you create the resource
group and attach the policies, you might configure the resource group to perform a full backup daily and
another schedule that performs log backups hourly. The following image illustrates the relationship between
resources, resource groups, and policies for databases:

Back up Exchange resources

Backup workflow

When you install the SnapCenter Plug-in for Microsoft Exchange Server in your
environment, you can use SnapCenter to back up Exchange resources.

You can schedule multiple backups to run across servers simultaneously. Backup and restore operations
cannot be performed simultaneously on the same resource. Active and passive backup copies on the same
volume are not supported.

The following workflow shows the sequence in which you must perform the backup operation:
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Exchange database and backup verification

SnapCenter Plug-in for Microsoft Exchange Server does not provide backup verification;
however, you can use the Eseutil tool provided with Exchange to verify Exchange
databases and backups.

The Microsoft Exchange Eseutil tool is a command line utility that is included with your Exchange server. The
utility enables you to perform consistency checks to verify the integrity of Exchange databases and backups.

Best Practice: It is not necessary to perform consistency checks on databases that are part of a Database
Availability Group (DAG) configuration with at least two replicas.

For additional information, see Microsoft Exchange Server documentation.

Determine whether Exchange resources are available for backup

Resources are the databases, Exchange Database Availability Groups that are
maintained by the plug-ins you have installed. You can add those resources to resource
groups so that you can perform data protection jobs, but first you must identify which
resources you have available. Determining available resources also verifies that the plug-
in installation has completed successfully.

What you will need
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• You must have already completed tasks such as installing SnapCenter Server, adding hosts, creating
storage system connections, adding credentials, and installing Plug-in for Exchange.

• To take advantage of Single Mailbox Recovery software features, you must have located your active
database on the Exchange Server where Single Mailbox Recovery software is installed.

• If databases reside on VMware RDM LUNs, you must deploy the SnapCenter Plug-in for VMware vSphere
and register the plug-in with SnapCenter. The SnapCenter Plug-in for VMware vSphere documentation has
more information.

About this task

• You cannot back up databases when the Overall Status option in the Details page is set to Not available
for backup. The Overall Status option is set to Not available for backup when any of the following is true:

◦ Databases are not on a NetApp LUN.

◦ Databases are not in normal state.

Databases are not in normal state when they are in mount, unmount, reseed, or recovery pending
state.

• If you have a Database Availability Group (DAG), you can back up all databases in the group by running
the backup job from the DAG.

Steps

1. In the left navigation pane, click Resources, and then select Microsoft Exchange Server from the plug-
ins drop-down list located in the upper left corner of the Resources page.

2. In the Resources page select Database, or Database Availability Group, or Resource Group, from the
View drop-down list.

All the databases and DAGs are displayed with their DAG or hostnames in FQDN format, so you can
distinguish between multiple databases.

Click  and select the host name and the Exchange Server to filter the resources. You can then click  to
close the filter pane.

3. Click Refresh Resources.

The newly added, renamed, or deleted resources are updated to the SnapCenter Server inventory.

You must refresh the resources if the databases are renamed outside of SnapCenter.

The resources are displayed along with information such as resource name, Database Availability Group
name, server in which the database is currently active, server with copies, time of last backup, and overall
status.

◦ If the database is on a non-NetApp storage, Not available for backup is displayed in the Overall Status
column.

In a DAG, if the active database copy is on non-NetApp storage and if at least one passive database
copy is on NetApp storage, Not protected is displayed in the Overall Status column.

You cannot perform data protection operations on a database that is on a non-NetApp storage type.
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◦ If the database is on NetApp storage and is not protected, Not protected is displayed in the Overall

Status column.

◦ If the database is on a NetApp storage system and protected, the user interface displays the Backup
not run message in the Overall Status column.

◦ If the database is on a NetApp storage system and is protected and if the backup is triggered for the
database, the user interface displays the Backup succeeded message in the Overall Status column.

Create backup policies for Exchange Server databases

You can create a backup policy for the Exchange resources or for the resource groups
before you use SnapCenter to back up Microsoft Exchange Server resources, or you can
create a backup policy at the time you create a resource group or back up a single
resource.

What you will need

• You must have defined your data protection strategy.

For details, see the information about defining a data protection strategy for Exchange databases.

• You must have prepared for data protection by completing tasks such as installing SnapCenter, adding
hosts, identifying resources, and creating storage system connections.

• You must have refreshed (discovered) the Exchange Server resources.

• If you are replicating Snapshot copies to a mirror or vault, the SnapCenter administrator must have
assigned the storage virtual machines (SVMs) for both the source volumes and destination volumes to you.

• If you want to run the PowerShell scripts in prescripts and postscripts, you should set the value of the

usePowershellProcessforScripts parameter to true in the web.config file.

The default value is false

About this task

• A backup policy is a set of rules that governs how you manage and retain backups, and how frequently the
resource or resource group is backed up. Additionally, you can specify script settings. Specifying options in
a policy saves time when you want to reuse the policy for another resource group.

• Full backup retention is specific to a given policy. A database or resource using policy A with a full backup
retention of 4 retains 4 full backups and has no effect on policy B for the same database or resource, which
might have a retention of 3 to retain 3 full backups.

• Log backup retention is effective across policies, and applies to all log backups for a database or resource.
Therefore, when a full backup is performed using policy B, the log retention setting affects log backups
created by policy A on the same database or resource. Similarly, the log retention setting for policy A
affects log backups created by policy B on the same database.

• The SCRIPTS_PATH is defined using the PredefinedWindowsScriptsDirectory key located in the
SMCoreServiceHost.exe.Config file of the plug-in host.

If needed, you can change this path and restart SMcore service. It is recommended that you use the
default path for security.

The value of the key can be displayed from swagger through the API: API /4.7/configsettings
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You can use the GET API to display the value of the key. SET API is not supported.

Best Practice: It’s best that you configure the secondary retention policy based on the number of full and log
backups, overall, that you want to retain. When you configure secondary retention policies, keep in mind that
when databases and logs that are in different volumes, each backup can have three Snapshot copies, and
when databases and logs are in the same volume, each backup can have two Snapshot copies.

Steps

1. In the left navigation pane, click Settings.

2. In the Settings page, click Policies.

3. Click New.

4. In the Name page, enter the policy name and description.

5. In the Backup Type page, perform the following steps:

a. Choose backup type:

If you want to… Do this…

Back up the database files and the required
transaction logs

Select Full backup and Log backup.

Databases are backed up with log truncation, and
all logs are backed up, including the truncated
logs.

This is the recommended backup
type.

Back up the database files and the uncommitted
transaction logs

Select Full backup.

Databases are backed up with log truncation, and
truncated logs are not backed up.

Back up all the transaction logs Select Log backup.

All transaction logs on the active file system are
backed up, and there is no log truncation.

A scebackupinfo directory is created on the same
disk as the live log. This directory contains the
pointer to the incremental changes for the
Exchange database and it is not equivalent to the
complete log files.

Back up all database files and transaction logs
without truncating the transaction log files

Select Copy Backup.

All databases and all logs are backed up, and
there is no log truncation. You typically use this
backup type for reseeding a replica or for testing
or diagnosing a problem.
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You should define the space required for log backups based on the full backup retention
and not based on Up-to-the-minute (UTM) retention.

Create separate vault policies for logs and databases when dealing with Exchange
volumes (LUNs), and set the keep (retention) for the log policy to twice the number for
each label as the database policy, using the same labels. For more information see,
SnapCenter for Exchange Backups only keep half the Snapshots on the Vault
destination log volume.

b. In the Database Availability Group Settings section, select an action:

For this field… Do this…

Back up active copies Select this option to back up only the active
copies of the selected database.

For database availability groups (DAGs), this
option backs up only active copies of all
databases in the DAG.

Passive copies are not backed up.

Back up copies on servers to be selected at
backup job creation time

Select this option to back up any copies of the
databases on the selected servers, both active
and passive.

For DAGs, this option backs up both active and
passive copies of all databases on the selected
servers.

In cluster configurations, the backups are retained at each node of the cluster according
to the retention settings set in the policy. If the owner node of the cluster changes, the
backups of the previous owner node will be retained. The retention is applicable only at
the node level.

c. In the Schedule frequency section, select one or more of the frequency types: On demand, Hourly,
Daily, Weekly, and Monthly.

You can specify the schedule (start date, end date) for backup operations while creating
a resource group. This enables you to create resource groups that share the same
policy and backup frequency, but lets you assign different backup schedules to each
policy.

If you have scheduled for 2:00 a.m., the schedule will not be triggered during daylight
saving time (DST).

6. In the Retention page, configure the retention settings.

The options displayed depend upon the backup type and frequency type you previously selected.
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The maximum retention value is 1018 for resources on ONTAP 9.4 or later, and 254 for
resources on ONTAP 9.3 or earlier. Backups will fail if retention is set to a value higher than
what the underlying ONTAP version supports.

You must set the retention count to 2 or higher if you plan to enable SnapVault replication. If
you set the retention count to 1, the retention operation might fail because the first Snapshot
copy is the reference Snapshot copy for the SnapVault relationship until a newer Snapshot
copy is replicated to the target.

a. In the Log backups retention settings section, select one of the following:

If you want to… Do this…

Retain only a specific number of log backups Select Number of full backups for which logs

are retained, and specify the number of full
backups for which you want up-to-the-minute
restorability.

Up-to-the-minute (UTM) retention applies to log
backup created via full or log backup. For
example, if UTM retention settings is configured to
retain log backups of the last 5 full backups, then
the log backups of the last 5 full backups are
retained.

The log folders created as part of full and log
backups are automatically deleted as part of
UTM. You cannot delete the log folders manually.
For example, if the retention setting of full or full
and log backup is set for 1 month and UTM
retention is set to 10 Days, then the log folder
created as part of these backups will be deleted
as per UTM. As a result, only 10 days log folders
will be there and all other backups are marked for
point-in-time restore.

You can set UTM retention value as 0, if you do
not want to perform up-to-the-minute restore. This
will enable point-in-time restore operation.

Best Practice: It’s best that the setting must be
equal to the setting for Total Snapshot copies (full
backups) in the Full backup retention settings
section. This ensures that log files are retained for
each full backup.

Retain the backup copies for a specific number of
days

Select the Keep log backups for last option, and
specify the number of days to keep the log
backup copies.

The log backups up to the number of days of full
backups are retained.
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If you selected Log backup as the backup type, log backups are retained as part of the up-to-the-
minute retention settings for full backups.

b. In the Full backup retention settings section, select one of the following for on-demand backups, and
then select one for full backups:

For this field… Do this…

Retain only a specific number of Snapshot copies If you want to specify the number of full backups
to keep, select the Total Snapshot copies to

keep option, and specify the number of Snapshot
copies (full backups) to retain.

If the number of full backups exceeds the
specified number, the full backups that exceed the
specified number are deleted, with the oldest
copies deleted first.

Retain full backups for a specific number of days Select the Keep Snapshot copies for option,
and specify the number of days to keep Snapshot
copies (full backups).

If you have a database with only log backups and no full backups on a host in a DAG
configuration, the log backups are retained in the following ways:

▪ By default, SnapCenter finds the oldest full backup for this database in all the other hosts in the
DAG, and deletes all log backups on this host that were taken before the full backup.

▪ You can override the above default retention behavior for a database on a host in a DAG with only
log backups by adding the key MaxLogBackupOnlyCountWithoutFullBackup in the C:\Program

Files\NetApp\SnapCenter WebApp\web.config file.

<add key="MaxLogBackupOnlyCountWithoutFullBackup" value="10">

In the example, the value 10 means you keep up to 10 log backups on the host.

7. In the Replication page, select one or both of the following secondary replication options:

For this field… Do this…

Update SnapMirror after creating a local Snapshot
copy

Select this option to keep mirror copies of backup
sets on another volume (SnapMirror).

Update SnapVault after creating a local Snapshot
copy

Select this option to perform disk-to-disk backup
replication.
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For this field… Do this…

Secondary policy label Select a Snapshot label.

Depending on the Snapshot copy label that you
select, ONTAP applies the secondary Snapshot
copy retention policy that matches the label.

If you have selected Update

SnapMirror after creating a local

Snapshot copy, you can optionally
specify the secondary policy label.
However, if you have selected
Update SnapVault after creating a

local Snapshot copy, you should
specify the secondary policy label.

Error retry count Enter the number of replication attempts that should
occur before the process halts.

You should configure SnapMirror retention policy in ONTAP for the secondary storage to
avoid reaching the maximum limit of Snapshot copies on the secondary storage.

8. In the Script page, enter the path and the arguments of the prescript or postscript that should be run before
or after the backup operation, respectively.

◦ Prescript backup arguments include “$Database” and “$ServerInstance”.

◦ Postscript backup arguments include “$Database”, “$ServerInstance”, “$BackupName”,
“$LogDirectory”, and “$LogSnapshot”.

You can run a script to update SNMP traps, automate alerts, send logs, and so on.

The prescripts or postscripts path should not include drives or shares. The path should
be relative to the SCRIPTS_PATH.

9. Review the summary, and then click Finish.

Create resource groups and attach policies for Exchange Servers

A resource group is required for any data protection job. You must also attach one or
more policies to the resource group to define the type of data protection job that you want
to perform and the protection schedule.

About this task

• The SCRIPTS_PATH is defined using the PredefinedWindowsScriptsDirectory key located in the
SMCoreServiceHost.exe.Config file of the plug-in host.

If needed, you can change this path and restart SMcore service. It is recommended that you use the
default path for security.
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The value of the key can be displayed from swagger through the API: API /4.7/configsettings

You can use the GET API to display the value of the key. SET API is not supported.

Steps

1. In the left navigation pane, click Resources, and then select the Microsoft Exchange Server plug-in from
the list.

2. In the Resources page, select Database from the View list.

If you have recently added a resource to SnapCenter, click Refresh Resources to view the
newly added resource.

3. Click New Resource Group.

4. In the Name page, perform the following actions:

For this field… Do this…

Name Enter the resource group name.

The resource group name should not
exceed 250 characters.

Tags Enter one or more labels that will help you later
search for the resource group.

For example, if you add HR as a tag to multiple
resource groups, you can later find all resource
groups associated with the HR tag.

Use custom name format for Snapshot copy Optional: Enter a custom Snapshot copy name and
format.

For example,
customtext_resourcegroup_policy_hostname or
resourcegroup_hostname. By default, a timestamp
is appended to the Snapshot copy name.

5. In the Resources page, perform the following steps:

a. Select the resource type and the Database Availability Group from drop-down lists to filter the list of
available resources.

If you have recently added resources, they will appear in the list of Available Resources
only after you refresh your resource list.

In the Available Resources and Selected Resources sections, the database name is displayed with the
FQDN of the host. This FQDN only indicates that the database is active on that specific host and might not
take backup on this host. You should select one or more backup servers from the Server selection option,
where you want to take backup in case you have selected the Back up copies on servers to be selected
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at backup job creation time option in the policy.

a. Type the name of the resource in the search text box, or scroll to locate a resource.

b. To move resources from the Available Resources section to the Selected Resources section, perform
one of the following steps:

▪ Select Autoselect all resources on same storage volume to move all of the resources on the
same volume to the Selected Resources section.

▪ Select the resources from the Available Resources section and then click the right arrow to move
them to the Selected Resources section.

Resource groups of SnapCenter for Microsoft Exchange Server cannot have more than 30
databases per Snapshot copy. If there are more than 30 databases in one resource group, a
second Snapshot copy is created for the additional databases. Therefore, 2 sub jobs are created
under the main backup job. For backups having secondary replication, while SnapMirror or
SnapVault update is in progress, there could be scenarios where the update for both the sub-jobs
overlap. The main backup job keeps on running forever even if the logs indicate that the job is
completed.

6. In the Policies page, perform the following steps:

a. Select one or more policies from the drop-down list.

You can also create a policy by clicking .

If a policy contains the Back up copies on servers to be selected at backup job

creation time option, a server selection option is displayed to select one or more
servers. The server selection option will list only the server where the selected database
is on NetApp storage.

In the Configure schedules for selected policies section, the selected policies are listed.

b.
In the Configure schedules for selected policies section, click  in the Configure Schedules

column for the policy for which you want to configure the schedule.

c. In the Add schedules for policy policy_name dialog box, configure the schedule by specifying the start
date, expiration date, and frequency, and then click OK.

You must do this for each frequency listed in the policy. The configured schedules are listed in the
Applied Schedules column in the Configure schedules for selected policies section.

Third party backup schedules are not supported when they overlap with SnapCenter backup
schedules.

7. In the Notification page, from the Email preference drop-down list, select the scenarios in which you want
to send the emails.

You must also specify the sender and receiver email addresses, and the subject of the email. If you want to
attach the report of the operation performed on the resource group, select Attach Job Report.

For email notification, you must have specified the SMTP server details either using the GUI or PowerShell

command Set-SmSmtpServer.
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The information regarding the parameters that can be used with the cmdlet and their descriptions can be
obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter
Software Cmdlet Reference Guide.

8. Review the summary, and then click Finish.

Back up Exchange databases

If a database is not part of any resource group, you can back up the database or
Database Availability Group from the Resources page.

What you will need

• You must have created a backup policy.

• You must have assigned the aggregate that is being used by the backup operation to the SVM used by the
database.

• If you want to back up a resource that has a SnapMirror relationship with a secondary storage, the role
assigned to the storage user should include the “snapmirror all” privilege. However, if you are using the
“vsadmin” role, then the “snapmirror all” privilege is not required.

• If you want to perform backup of a Database or a Database Availability Group which has active/passive
database copy on a NetApp and non-NetApp storage, and you have selected Back up active copies or
Back up copies on servers to be selected during backup job creation time option in the policy, then
the backup jobs will go in to warning state. The backup will succeed for active/passive database copy on
NetApp storage and backup will fail for active/passive database copy on non-NetApp storage.

Best Practice: Do not run backups of active and passive databases at the same time. A race condition
can occur and one of the backups might fail.

Steps

1. In the left navigation pane, click Resources, and then select the Microsoft Exchange Server plug-in from
the list.

2. In the Resources page, select either Database, or Database Availability Group from the View list.

In the Resources page, the  icon indicates that the database is on non-NetApp storage.

In a DAG, If an active database copy is on a non-NetApp storage and at least one passive
database copy resides on a NetApp storage, then you can protect the database.

Click , and then select the host name and the database type to filter the resources. You can then click 
to close the filter pane.

◦ If you want to back up a database, click on the database name.

i. If the Topology view is displayed, click Protect.

ii. If the Database - Protect Resource wizard is displayed, continue to Step 3.

◦ If you want to back up a Database Availability Group, click on the Database Availability Group name.

3. If you want to specify a custom Snapshot copy name, in the Resources page, select the Use custom

name format for Snapshot copy check box, and then enter a custom name format that you want to use
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for the Snapshot copy name.

For example, customtext_policy_hostname or resource_hostname. By default, a timestamp is appended to
the Snapshot copy name.

4. In the Policies page, perform the following steps:

a. Select one or more policies from the drop-down list.

You can also create a policy by clicking .

If a policy contains the Back up copies on servers to be selected at backup job

creation time option, a server selection option is displayed to select one or more
servers. The server selection option will list only the server where the selected database
is on a NetApp storage.

In the Configure schedules for selected policies section, the selected policies are listed.

a.
Click  in the Configure Schedules column for the policy for which you want to configure a
schedule.

b. In the Add schedules for policy policy_name window, configure the schedule, and then click OK.

Where, policy_name is the name of the policy that you have selected.

The configured schedules are listed in the Applied Schedules column.

5. In the Notification page, from the Email preference drop-down list, select the scenarios in which you want
to send the emails.

You must also specify the sender and receiver email addresses, and the subject of the email. If you want to
attach the report of the backup operation performed on the resource, select Attach Job Report.

For email notification, you must have specified the SMTP server details using the either the
GUI or the PowerShell command Set-SmSmtpServer.

6. Review the summary, and then click Finish.

The database topology page is displayed.

7. Click Back up Now.

8. In the Backup page, perform the following steps:

a. If you have applied multiple policies to the resource, from the Policy drop-down list, select the policy
that you want to use for backup.

If the policy selected for the on-demand backup is associated with a backup schedule, the on-demand
backups will be retained based on the retention settings specified for the schedule type.

b. Click Backup.

9. Monitor the backup’s progress by double-clicking the job in the Activity pane at the bottom of the page to
display the Job Details page.
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◦ In MetroCluster configurations, SnapCenter might not be able to detect a protection relationship after a
failover.

For information, see: Unable to detect SnapMirror or SnapVault relationship after MetroCluster failover

◦ If you are backing up application data on VMDKs and the Java heap size for the SnapCenter Plug-in
for VMware vSphere is not large enough, the backup might fail.

To increase the Java heap size, locate the script file /opt/netapp/init_scripts/scvservice. In that script,
the do_start method command starts the SnapCenter VMware plug-in service. Update that command
to the following: Java -jar -Xmx8192M -Xms4096M

Back up Exchange resources groups

A resource group is a collection of resources on a host or Exchange DAG, and the
resource group can include either a whole DAG or individual databases. You can backup
the resources groups from the Resources page.

What you will need

• You must have created a resource group with a policy attached.

• You must have assigned the aggregate that is being used by the backup operation to the storage virtual
machine (SVM) used by the database.

• If you want to back up a resource that has a SnapMirror relationship with a secondary storage, the role
assigned to the storage user should include the “snapmirror all” privilege. However, if you are using the
“vsadmin” role, then the “snapmirror all” privilege is not required.

• If a resource group has multiple databases from different hosts, the backup operation on some of the hosts
might start late because of network issues. You should configure the value of

MaxRetryForUninitializedHosts in web.config by using the Set-SmConfigSettings
PowerShell cmdlet.

• In a resource group, if you include a Database or Database Availability Group which has active/passive
database copy on a NetApp and non-NetApp storage, and you have selected Back up active copies or
Back up copies on servers to be selected during backup job creation time option in the policy, then
the backup jobs will go into warning state.

The backup will succeed for active/passive database copy on NetApp storage and backup will fail for
active/passive database copy on non-NetApp storage.

About this task

You can back up a resource group on demand from the Resources page. If a resource group has a policy
attached and a schedule configured, then backups occur automatically according to the schedule.

Steps

1. In the left navigation pane, click Resources, and then select the Microsoft Exchange Server plug-in from
the list.

2. In the Resources page, select Resource Group from the View list.

You can search the resource group either by entering the resource group name in the search box or by
clicking , and then selecting the tag. You can then click  to close the filter pane.
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3. In the Resource Groups page, select the resource group that you want to back up, and then click Back up

Now.

4. In the Backup page, perform the following steps:

a. If you have associated multiple policies with the resource group, from the Policy drop-down list, select
the policy that you want to use for backup.

If the policy selected for the on-demand backup is associated with a backup schedule, the on-demand
backups will be retained based on the retention settings specified for the schedule type.

b. Click Backup.

5. Monitor the backup’s progress by double-clicking the job in the Activity pane at the bottom of the page to
display the Job Details page.

Create a storage system connection and a credential using PowerShell cmdlets for
Exchange Server

You must create a storage virtual machine (SVM) connection and a credential before
using PowerShell cmdlets to back up and restore.

What you will need

• You should have prepared the PowerShell environment to execute the PowerShell cmdlets.

• You should have the required permissions in the Infrastructure Admin role to create storage connections.

• You should ensure that the plug-in installations are not in progress.

Host plug-in installations must not be in progress while adding a storage system connection because the
host cache might not be updated and databases status might be displayed in the SnapCenter GUI as “Not
available for backup” or “Not on NetApp storage”.

• Storage system names should be unique.

SnapCenter does not support multiple storage systems with the same name on different clusters. Each
storage system that is supported by SnapCenter should have a unique name and a unique data LIF IP
address.

Steps

1. Initiate a PowerShell connection session by using the Open-SmConnection cmdlet.

This example opens a PowerShell session:

PS C:\> Open-SmConnection

2. Create a new connection to the storage system by using the Add-SmStorageConnection cmdlet.

This example creates a new storage system connection:
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PS C:\> Add-SmStorageConnection -SVM test_vs1 -Protocol Https

-Timeout 60

3. Create a new Run As account by using the Add-Credential cmdlet.

This example creates a new Run As account named ExchangeAdmin with Windows credentials:

PS C:> Add-SmCredential -Name ExchangeAdmin -AuthMode Windows

-Credential sddev\administrator

The information regarding the parameters that can be used with the cmdlet and their descriptions can be
obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter Software
Cmdlet Reference Guide.

Back up Exchange resources using PowerShell cmdlets

Backing up an Exchange Server database includes establishing a connection with the
SnapCenter Server, discovering the Exchange Server database, adding a policy, creating
a backup resource group, backing up, and viewing the backup status.

What you will need

• You must have prepared the PowerShell environment to execute the PowerShell cmdlets.

• You must have added the storage system connection and created a credential.

• You must have added hosts and discovered resources.

Plug-in for Exchange does not support clone operations; therefore, the CloneType parameter for
the Add-SmPolicy cmdlet is not supported for Plug-in for Exchange

Steps

1. Initiate a connection session with the SnapCenter Server for a specified user by using the Open-
SmConnection cmdlet.

Open-smconnection  -SMSbaseurl  https://snapctr.demo.netapp.com:8146/

The username and password prompt is displayed.

2. Create a backup policy by using the Add-SmPolicy cmdlet.

This example creates a new backup policy with a full backup and log backup Exchange backup type:
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C:\PS> Add-SmPolicy -PolicyName SCE_w2k12_Full_Log_bkp_Policy

-PolicyType Backup -PluginPolicytype SCE -SceBackupType

FullBackupAndLogBackup -BackupActiveCopies

This example creates a new backup policy with an hourly full backup and log backup Exchange backup
type:

C:\PS> Add-SmPolicy -PolicyName SCE_w2k12_Hourly_Full_Log_bkp_Policy

-PolicyType Backup -PluginPolicytype SCE -SceBackupType

FullBackupAndLogBackup -BackupActiveCopies -ScheduleType Hourly

-RetentionSettings

@{'BackupType'='DATA';'ScheduleType'='Hourly';'RetentionCount'='10'}

This example creates a new backup policy to back up only Exchange logs:

Add-SmPolicy -PolicyName SCE_w2k12_Log_bkp_Policy -PolicyType Backup

-PluginPolicytype SCE -SceBackupType LogBackup -BackupActiveCopies

3. Discover host resources by using the Get-SmResources cmdlet.

This example discovers the resources for the Microsoft Exchange Server plug-in on the specified host:

C:\PS> Get-SmResources -HostName vise-f6.sddev.mycompany.com -PluginCode

SCE

4. Add a new resource group to SnapCenter by using the Add-SmResourceGroup cmdlet.

This example creates a new Exchange Server database backup resource group with the specified policy
and resources:

C:\PS> Add-SmResourceGroup -ResourceGroupName SCE_w2k12_bkp_RG

-Description 'Backup ResourceGroup with Full and Log backup policy'

-PluginCode SCE -Policies

SCE_w2k12_Full_bkp_Policy,SCE_w2k12_Full_Log_bkp_Policy,SCE_w2k12_Log_bk

p_Policy -Resources @{'Host'='sce-w2k12-exch';'Type'='Exchange

Database';'Names'='sce-w2k12-exch.sceqa.com\sce-w2k12-exch_DB_1,sce-

w2k12-exch.sceqa.com\sce-w2k12-exch_DB_2'}

This example creates a new Exchange Database Availability Group (DAG) backup resource group with the
specified policy and resources:
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Add-SmResourceGroup -ResourceGroupName SCE_w2k12_bkp_RG -Description

'Backup ResourceGroup with Full and Log backup policy' -PluginCode SCE

-Policies

SCE_w2k12_Full_bkp_Policy,SCE_w2k12_Full_Log_bkp_Policy,SCE_w2k12_Log_bk

p_Policy -Resources @{"Host"="DAGSCE0102";"Type"="Database Availability

Group";"Names"="DAGSCE0102"}

5. Initiate a new backup job by using the New-SmBackup cmdlet.

C:\PS> New-SmBackup -ResourceGroupName SCE_w2k12_bkp_RG -Policy

SCE_w2k12_Full_Log_bkp_Policy

This example creates a new backup to secondary storage:

New-SMBackup -DatasetName ResourceGroup1 -Policy

Secondary_Backup_Policy4

6. View the status of the backup job by using the Get-SmBackupReport cmdlet.

This example displays a job summary report of all jobs that were run on the specified date:

C:\PS> Get-SmJobSummaryReport -Date ?1/27/2018?

This example displays a job summary report for a specific job ID:

C:\PS> Get-SmJobSummaryReport -JobId 168

The information regarding the parameters that can be used with the cmdlet and their descriptions can be
obtained by running Get-Help command_name. Alternatively, see SnapCenter Software Cmdlet Reference
Guide.

Monitor backup operations

You can monitor the progress of different backup operations by using the SnapCenterJobs page. You might
want to check the progress to determine when it is complete or if there is an issue.

About this task

The following icons appear on the Jobs page and indicate the corresponding state of the operations:

•
 In progress

•  Completed successfully

50

https://library.netapp.com/ecm/ecm_download_file/ECMLP2883300
https://library.netapp.com/ecm/ecm_download_file/ECMLP2883300


•  Failed

•
 Completed with warnings or could not start due to warnings

•  Queued

•  Canceled

Steps

1. In the left navigation pane, click Monitor.

2. In the Monitor page, click Jobs.

3. In the Jobs page, perform the following steps:

a. Click  to filter the list so that only backup operations are listed.

b. Specify the start and end dates.

c. From the Type drop-down list, select Backup.

d. From the Status drop-down, select the backup status.

e. Click Apply to view the operations completed successfully.

4. Select a backup job, and then click Details to view the job details.

Though the backup job status displays , when you click on job details you might see that
some of the child tasks of the backup operation are still in progress or marked with warning
signs.

5. In the Job Details page, click View logs.

The View logs button displays the detailed logs for the selected operation.

Monitor operations in the Activity pane

The Activity pane displays the five most recent operations performed. The Activity pane also displays when the
operation was initiated and the status of the operation.

The Activity pane displays information regarding backup, restore, clone, and scheduled backup operations. If
you are using Plug-in for SQL Server or Plug-in for Exchange Server, the Activity pane also displays
information about the reseed operation.

Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.

2. Click  on the Activity pane to view the five most recent operations.

When you click one of the operations, the operation details are listed in the Job Details page.

Cancel backup operations for Exchange database

You can cancel backup operations that are queued.

What you will need
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• You must be logged in as the SnapCenter Admin or job owner to cancel operations.

• You can cancel a backup operation from either the Monitor page or the Activity pane.

• You cannot cancel a running backup operation.

• You can use the SnapCenter GUI, PowerShell cmdlets, or CLI commands to cancel the backup operations.

• The Cancel Job button is disabled for operations that cannot be canceled.

• If you selected All members of this role can see and operate on other members objects in
Users\Groups page while creating a role, you can cancel the queued backup operations of other members
while using that role.

Steps

1. Perform one of the following actions:

From the… Action

Monitor page a. In the left navigation pane, click Monitor >
Jobs.

b. Select the operation, and then click Cancel

Job.

Activity pane a. After initiating the backup operation, click  on
the Activity pane to view the five most recent
operations.

b. Select the operation.

c. In the Job Details page, click Cancel Job.

The operation is canceled, and the resource is reverted to the previous state.

Remove Exchange backups using PowerShell cmdlets

You can use the Remove-SmBackup cmdlet to delete Exchange backups if you no longer
require them for other data protection operations.

You must have prepared the PowerShell environment to execute the PowerShell cmdlets.

The information regarding the parameters that can be used with the cmdlet and their descriptions can be
obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter Software
Cmdlet Reference Guide.

Steps

1. Initiate a connection session with the SnapCenter Server for a specified user by using the Open-
SmConnection cmdlet.

Open-SmConnection  -SMSbaseurl  https://snapctr.demo.netapp.com:8146/

2. Delete one or more backup using the Remove-SmBackup cmdlet.

52

https://library.netapp.com/ecm/ecm_download_file/ECMLP2883300
https://library.netapp.com/ecm/ecm_download_file/ECMLP2883300


This example deletes two backups using their backup IDs:

Remove-SmBackup -BackupIds 3,4

Remove-SmBackup

Are you sure want to remove the backup(s).

[Y] Yes  [A] Yes to All  [N] No  [L] No to All  [S] Suspend  [?] Help

(default is "Y"):

View Exchange backups in the Topology page

When you are preparing to back up a resource, you might find it helpful to view a
graphical representation of all backups on the primary and secondary storages.

About this task

In the Topology page, you can see all of the backups that are available for the selected resource or resource
group. You can view the details of those backups, and then select them to perform data protection operations.

You can review the following icon in the Manage Copies view to determine whether the backups are available
on the primary or secondary storage (Mirror copies or Vault copies).

•

 displays the number of backups that are available on the primary storage.

•

 displays the number of backups that are mirrored on the secondary storage using SnapMirror
technology.

•

 displays the number of backups that are replicated on the secondary storage using SnapVault
technology.

◦ The number of backups displayed includes the backups deleted from the secondary storage.

For example, if you created 6 backups using a policy to retain only 4 backups, the number of backups
displayed is 6.

Best Practice: To ensure the correct number of replicated backups is displayed, we recommend that you
refresh the topology.

Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.

2. In the Resources page, select the database, or the resource, or the resource group from the View drop-
down list.

3. Select the resource either from the database details view or from the resource group details view.
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If the resource is protected, the Topology page of the selected resource is displayed.

4. Review the Summary card section to see a summary of the number of backups available on the primary
and secondary storage.

The Summary Card section displays the total number of backups and total number of log backups.

Clicking the Refresh button starts a query of the storage to display an accurate count.

5. In the Manage Copies view, click Backups from the primary or secondary storage to see details of a
backup.

The details of the backups are displayed in a table format.

6. Select the backup from the table, and then click the data protection icons to perform restore, rename, and
delete operations.

You cannot rename or delete backups that are on the secondary storage. Deleting Snapshot
copies is handled by ONTAP retention settings.

Restore Exchange resources

Restore workflow

You can use SnapCenter to restore Exchange databases by restoring one or more
backups to your active file system.

The following workflow shows the sequence in which you must perform the Exchange database restore
operations:

You can also use PowerShell cmdlets manually or in scripts to perform backup and restore operations. For
detailed information about PowerShell cmdlets, use the SnapCenter cmdlet help or see SnapCenter Software
Cmdlet Reference Guide.

Requirements for restoring an Exchange database

Before you restore an Exchange Server database from a SnapCenter Plug-in for
Microsoft Exchange Server backup, you must ensure that several requirements are met.

To use the restore functionality completely, you must upgrade both SnapCenter Server and
SnapCenter Plug-in for Exchange database to 4.6.
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• The Exchange Server must be online and running before you can restore a database.

• The databases must exist on the Exchange Server.

Restoring deleted databases is not supported.

• SnapCenter schedules for the database must be suspended.

• The SnapCenter Server and the SnapCenter Plug-in for Microsoft Exchange Server host must be
connected to the primary and secondary storage that contains the backups you want to restore.

Restore Exchange databases

You can use SnapCenter to restore backed-up Exchange databases.

What you will need

• You must have backed up the resource groups, database, or Database Availability Groups (DAGs).

• When Exchange database is migrated to another location, restore operation does not work for old backups.

• If you are replicating Snapshot copies to a mirror or vault, the SnapCenter administrator must have
assigned you the SVMs for both the source volumes and destination volumes.

• In a DAG, if an active database copy is on a non-NetApp storage and you want to restore from the passive
database copy backup that is on a NetApp storage, make the passive copy (NetApp storage) as active
copy, refresh the resources and perform the restore operation.

Run the Move-ActiveMailboxDatabase command to make the passive database copy as active
database copy.

The Microsoft documentation contains information about this command.

About this task

• When restore operation is performed on a database, the database is mounted back on the same host and
no new volume is created.

• DAG-level backups must be restored from individual databases.

• Full disk restore is not supported when files other than Exchange database (.edb) file exist.

Plug-in for Exchange does not perform a full restore on a disk if the disk contains Exchange files such as
those used for replication. When a full restore might impact Exchange functionality, Plug-in for Exchange
performs a single file restore operation.

• Plug-in for Exchange cannot restore BitLocker encrypted drives.

• The SCRIPTS_PATH is defined using the PredefinedWindowsScriptsDirectory key located in the
SMCoreServiceHost.exe.Config file of the plug-in host.

If needed, you can change this path and restart SMcore service. It is recommended that you use the
default path for security.

The value of the key can be displayed from swagger through the API: API /4.7/configsettings

You can use the GET API to display the value of the key. SET API is not supported.
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Steps

1. On the left navigation pane, click Resources in the upper left corner of the Resource page.

2. Select the Exchange Server plug-in from the drop-down list.

3. In the Resources page, select Database from the View list.

4. Select the database from the list.

5.
From the Manage Copies view, select Backups, from the Primary Backups table, and then click .

6. In the Options page, select one of the following log backup options:

Option Description

All log backups Choose All log backups to perform up-to-the-
minute backup restore operation to restore all of the
available log backups after the full backup.

By log backups until Choose By log backups until to perform a point-in-
time restore operation, which restores the database
based on log backups until the selected log.

The number of logs displayed in the
drop-down list are based on UTM.
For example, if full backup retention
is 5 and UTM retention is 3, the
number of log backups available are
5 but in the drop-down only 3 logs
will be listed to perform restore
operation.

By specific date until Choose By specific date until to specify the date
and time up to which transaction logs are applied to
the restored database. This point-in-time restore
operation restores transaction log entries that were
recorded until the last backup on the specified date
and time.

None Choose None when you need to restore only the full
backup without any log backups.

You can perform one of the following actions:

◦ Recover and mount database after restore - This option is selected by default.

◦ Do not verify the integrity of transaction logs in the backup before restore - By default,
SnapCenter verifies the integrity of transaction logs in a backup before performing a restore operation.

Best Practice: You should not select this option.

7. In the Script page, enter the path and the arguments of the prescript or postscript that should be run before
or after the restore operation, respectively.
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Restore prescript arguments include $Database and $ServerInstance.

Restore postscript arguments include $Database, $ServerInstance, $BackupName, $LogDirectory, and
$TargetServerInstance.

You can run a script to update SNMP traps, automate alerts, send logs, and so on.

The prescripts or postscripts path should not include drives or shares. The path should be
relative to the SCRIPTS_PATH.

8. In the Notification page, from the Email preference drop-down list, select the scenarios in which you want
to send the emails.

You must also specify the sender and receiver email addresses, and the subject of the email.

9. Review the summary, and then click Finish.

10. You can view the status of the restore job by expanding the Activity panel at the bottom of the page.

You should monitor the restore process by using the Monitor > Jobs page.

When you restore an active database from a backup, the passive database might go into suspended or failed
state if there is a lag between the replica and the active database.

The state change can occur when the active database’s log chain forks and begins a new branch which breaks
replication. Exchange Server attempts to fix the replica, but if it is unable to do so, after restore, you should
create a fresh backup, and then reseed the replica.

Granular recovery of mails and mailbox

Single Mailbox Recovery (SMBR) software allows you to restore and recover mails or
mailbox instead of the complete Exchange Database.

Restoring complete database just to recover a single mail will consume lot of time and resource. SMBR helps
in quickly recovering the mails by creating clone copy of the Snapshot and then using Microsoft API’s to mount
the mailbox in SMBR. For information on how to use SMBR, see SMBR Administration Guide.

For additional information on SMBR, refer the following:

• How to manually restore a single item with SMBR ( also applicable for Ontrack Power Control restores)

• How to restore from secondary storage in SMBR with SnapCenter

• Recovering Microsoft Exchange Mail From SnapVault Using SMBR

Restore an Exchange Server database from secondary storage

You can restore a backed up Exchange Server database from secondary storage (mirror
or vault).

You must have replicated the Snapshot copies from primary storage to a secondary storage.

Steps
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1. In the left navigation pane, click Resources, and then select Microsoft Exchange Server plug-in from the
list.

2. In the Resources page, select Database or Resource Group from the View drop-down list.

3. Select the database or the resource group.

The database or resource group topology page is displayed.

4. In the Manage Copies section, select Backups from the secondary storage system (mirror or vault).

5.
Select the backup from the list, and then click .

6. In the Location page, choose the destination volume for restoring the selected resource.

7. Complete the Restore wizard, review the summary, and then click Finish.

Restore Exchange resources using PowerShell cmdlets

Restoring an Exchange database includes initiating a connection session with the
SnapCenter Server, listing the backups and retrieving backup information, and restoring a
backup.

You must have prepared the PowerShell environment to execute the PowerShell cmdlets.

Steps

1. Initiate a connection session with the SnapCenter Server for a specified user by using the Open-

SmConnection cmdlet.

Open-smconnection  -SMSbaseurl  https://snapctr.demo.netapp.com:8146/

2. Retrieve the information about the one or more backups that you want to restore by using the Get-

SmBackup cmdlet.

This example displays information about all available backups:
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PS C:\> Get-SmBackup

BackupId                      BackupName                    BackupTime

BackupType

--------                      ----------                    ----------

----------

341                           ResourceGroup_36304978_UTM... 12/8/2017

4:13:24 PM          Full Backup

342                           ResourceGroup_36304978_UTM... 12/8/2017

4:16:23 PM          Full Backup

355                           ResourceGroup_06140588_UTM... 12/8/2017

6:32:36 PM          Log Backup

356                           ResourceGroup_06140588_UTM... 12/8/2017

6:36:20 PM          Full Backup

3. Restore data from the backup by using the Restore-SmBackup cmdlet.

This example restores an up-to-the-minute backup:

C:\PS> Restore-SmBackup -PluginCode SCE -AppObjectId 'sce-w2k12-

exch.sceqa.com\sce-w2k12-exch_DB_2' -BackupId 341 -IsRecoverMount:$true

This example restores a point-in-time backup:

C:\ PS> Restore-SmBackup -PluginCode SCE -AppObjectId 'sce-w2k12-

exch.sceqa.com\sce-w2k12-exch_DB_2' -BackupId 341 -IsRecoverMount:$true

-LogRestoreType ByTransactionLogs -LogCount 2

This example restores a backup on secondary storage to primary story:

C:\ PS> Restore-SmBackup -PluginCode 'SCE' -AppObjectId 'DB2' -BackupId

81 -IsRecoverMount:$true -Confirm:$false

-archive @{Primary="paw_vs:vol1";Secondary="paw_vs:vol1_mirror"}

-logrestoretype All

The -archive parameter enables you to specify the primary and secondary volumes you want to use for
the restore.

The -IsRecoverMount:$true parameter enables you to mount the database after the restore.

The information regarding the parameters that can be used with the cmdlet and their descriptions can be
obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter Software
Cmdlet Reference Guide.
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Reseed a passive Exchange node replica

If you need to reseed a replica copy, for instance when a copy is corrupt, you can reseed
to the latest backup using the reseed feature in SnapCenter.

What you will need

• You must be using SnapCenter Server 4.1 or later, and Plug-in for Exchange 4.1 or later.

Reseeding a replica is not supported in SnapCenter versions earlier than 4.1.

• You must have created a backup of the database you want to reseed.

Best Practice: To avoid lagging between nodes, we recommend that you either create a new backup before
you perform a reseed operation, or choose the host with the latest backup.

Steps

1. In the left navigation pane, click Resources, and then select Microsoft Exchange Server plug-in from the
list.

2. In the Resources page, select the appropriate option from the View list:

Option Description

To reseed a single database Select Database from the View list.

To reseed databases in a DAG Select Database Availability Group from the View
list.

3. Select the resource you want to reseed.

4. In the Manage Copies page, click Reseed.

5. From the list of unhealthy databases copies in the Reseed wizard, select the one you want to reseed, and
then click Next.

6. In the Host window, select the host with the backup from which you want to reseed, and then click Next.

7. In the Notification page, from the Email preference drop-down list, select the scenarios in which you want
to send the emails.

You must also specify the sender and receiver email addresses, and the subject of the email.

8. Review the summary, and then click Finish.

9. You can view the status of the job by expanding the Activity panel at the bottom of the page.

Reseed operation is not supported if the passive database copy resides on non-NetApp
storage.

Reseed a replica using PowerShell cmdlets for Exchange database

You can use PowerShell cmdlets to restore an unhealthy replica by using either the most

60



recent copy on the same host or the most recent copy from an alternate host.

The information regarding the parameters that can be used with the cmdlet and their descriptions can be
obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter Software
Cmdlet Reference Guide.

Steps

1. Initiate a connection session with the SnapCenter Server for a specified user by using the Open-

SmConnection cmdlet.

Open-smconnection  -SMSbaseurl  https:\\snapctr.demo.netapp.com:8146/

2. Reseed the database by using the reseed-SmDagReplicaCopy cmdlet.

This example reseeds the failed copy of the database called execdb on the host "mva-rx200.netapp.com"
using the latest backup on that host.

reseed-SmDagReplicaCopy -ReplicaHost "mva-rx200.netapp.com" -Database

execdb

This example reseeds the failed copy of the database called execdb using the latest backup of the
database (production/copy) on an alternate host "mva-rx201.netapp.com."

reseed-SmDagReplicaCopy -ReplicaHost "mva-rx200.netapp.com" -Database

execdb -BackupHost "mva-rx201.netapp.com"

Monitor restore operations

You can monitor the progress of different SnapCenter restore operations by using the Jobs page. You might
want to check the progress of an operation to determine when it is complete or if there is an issue.

About this task

Post-restore states describe the conditions of the resource after a restore operation and any further restore
actions that you can take.

The following icons appear on the Jobs page, and indicate the state of the operation:

•
 In progress

•  Completed successfully

•  Failed

•
 Completed with warnings or could not start due to warnings

•  Queued
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•  Canceled

Steps

1. In the left navigation pane, click Monitor.

2. In the Monitor page, click Jobs.

3. In the Jobs page, perform the following steps:

a. Click  to filter the list so that only restore operations are listed.

b. Specify the start and end dates.

c. From the Type drop-down list, select Restore.

d. From the Status drop-down list, select the restore status.

e. Click Apply to view the operations that have been completed successfully.

4. Select the restore job, and then click Details to view the job details.

5. In the Job Details page, click View logs.

The View logs button displays the detailed logs for the selected operation.

After the volume based restore operation, the backup metadata is deleted from the
SnapCenter repository but the backup catalog entries remain in SAP HANA catalog. Though
the restore job status displays , you should click on job details to see the warning sign of
some of the child tasks. Click on the warning sign and delete the indicated backup catalog
entries.

Cancel restore operations for Exchange database

You can cancel restore jobs that are queued.

You should be logged in as the SnapCenter Admin or job owner to cancel restore operations.

About this task

• You can cancel a queued restore operation from either the Monitor page or the Activity pane.

• You cannot cancel a running restore operation.

• You can use the SnapCenter GUI, PowerShell cmdlets, or CLI commands to cancel the queued restore
operations.

• The Cancel Job button is disabled for restore operations that cannot be canceled.

• If you selected All members of this role can see and operate on other members objects in
Users\Groups page while creating a role, you can cancel the queued restore operations of other members
while using that role.

Step

Perform one of the following actions:
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From the… Action

Monitor page a. In the left navigation pane, click Monitor > Jobs.

b. Select the job and click Cancel Job.

Activity pane a. After initiating the restore operation, click  on
the Activity pane to view the five most recent
operations.

b. Select the operation.

c. In the Job Details page, click Cancel Job.

63



Copyright information

Copyright © 2024 NetApp, Inc. All Rights Reserved. Printed in the U.S. No part of this document covered by
copyright may be reproduced in any form or by any means—graphic, electronic, or mechanical, including
photocopying, recording, taping, or storage in an electronic retrieval system—without prior written permission
of the copyright owner.

Software derived from copyrighted NetApp material is subject to the following license and disclaimer:

THIS SOFTWARE IS PROVIDED BY NETAPP “AS IS” AND WITHOUT ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE, WHICH ARE HEREBY DISCLAIMED. IN NO EVENT SHALL
NETAPP BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

NetApp reserves the right to change any products described herein at any time, and without notice. NetApp
assumes no responsibility or liability arising from the use of products described herein, except as expressly
agreed to in writing by NetApp. The use or purchase of this product does not convey a license under any
patent rights, trademark rights, or any other intellectual property rights of NetApp.

The product described in this manual may be protected by one or more U.S. patents, foreign patents, or
pending applications.

LIMITED RIGHTS LEGEND: Use, duplication, or disclosure by the government is subject to restrictions as set
forth in subparagraph (b)(3) of the Rights in Technical Data -Noncommercial Items at DFARS 252.227-7013
(FEB 2014) and FAR 52.227-19 (DEC 2007).

Data contained herein pertains to a commercial product and/or commercial service (as defined in FAR 2.101)
and is proprietary to NetApp, Inc. All NetApp technical data and computer software provided under this
Agreement is commercial in nature and developed solely at private expense. The U.S. Government has a non-
exclusive, non-transferrable, nonsublicensable, worldwide, limited irrevocable license to use the Data only in
connection with and in support of the U.S. Government contract under which the Data was delivered. Except
as provided herein, the Data may not be used, disclosed, reproduced, modified, performed, or displayed
without the prior written approval of NetApp, Inc. United States Government license rights for the Department
of Defense are limited to those rights identified in DFARS clause 252.227-7015(b) (FEB 2014).

Trademark information

NETAPP, the NETAPP logo, and the marks listed at http://www.netapp.com/TM are trademarks of NetApp, Inc.
Other company and product names may be trademarks of their respective owners.

64

http://www.netapp.com/TM

	Protect Microsoft Exchange Server databases : SnapCenter Software 4.7
	Table of Contents
	Protect Microsoft Exchange Server databases
	SnapCenter Plug-in for Microsoft Exchange Server concepts
	Install SnapCenter Plug-in for Microsoft Exchange Server
	Install SnapCenter Plug-in for VMware vSphere
	Prepare for data protection
	Back up Exchange resources
	Restore Exchange resources


